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What's New - Realism
The display is now more realistic of the stitched design.

The fabric can be selected from Aida, plastic canvas, tapestry canvas etc    in a variety of 
colours.    Should a colour be required that is not listed, please send a sample to the author 
and it will be added.

Stitches now appear more realistic too with one half cross appearing to go over the other.    
There is also more of a "depth" look to them rather than being a flat single colour cross.

Also new to Version 5 is the Tapestry stitch mode.    This displays all cross stitches as a single
diagonal stitch with added width in order to simulate the look of a tapestry design.    This 
enables a design to be viewed as both Cross Stitch and Tapestry.

For obvious reasons, the tapestry stitches look best when combined with the tapestry 
canvas and the cross stitches when combined with the aida canvas however they can be 
mixed.

Return to What's new V5



What's New - Speed
The speed of loading and saving designs has been improved by around 30%.    The speed of 
screen redraws has improved slightly despite the extra complexity of the new realistic fabric 
modes.    The speed of the block draw mode is almost doubled.

The speed of floodfill has been significantly improved where the area to fill is of reasonable 
size.    Where a larger number of stitches are affected by floodfill, a warning is now given and
a chance to cancel.

Screen redrawing has been dissabled during the display of some dialogs to avoid having to 
wait for redraws at times when the design display is not important.

Return to What's new V5



What's New - Block Commands
There are three new commands that operate on selected areas of the design.    The Block 
menu has also been renamed the Area menu.

Auto Backstitch
The boundary of each colour change in the block is determined and then backstitch is 
applied in the currently selected colour.    This is an instant way to add backstitch to the 
design and saves a great deal of time.

Auto Smooth
Any colour change in the design or any border with the background fabric will be smoothed 
out by the addition of 3/4 stitches of the appropriate colour and orientation.    This is another 
great time saver.

Swap Colour
This enables you to swap all stitches of one colour with any colour in the selected palette.    A
yellow prompt sheet replaces the Superview whilst using this command to give extra help.    
You need to first click on a stitch of the colour to be replaced and then click on the 
replacement colour in the colour palette.    Note that any matching stitches outside the 
currently selected area are not affected.

Knots and Beads
The Area commands now operate on French knots and beads.    Previously knots were left 
unchanged by these commands.

Return to What's new V5



What's New - Stitches
There are currently 3 new stitch types:

1/4 Stitches
Each of the four quarters in a stitch position can now be a different colour.    A seperate tool 
is provided for each of the orientations of the 1/4 stitch.

Half Cross
A diagonal "Half Cross" stitch has been added.    Each orientation has a seperate tool.    On 
screen, this looks similar to a single length backstitch in the appropriate colour however on 
the printed patten, it will be shown as 2 half sized symbols in opposite corners of the square.

Beads
A Bead can now be added either on the same grid as the stitches, or inbetween the stitch 
positions.    There are thus 9 possible positions around each stitch (including the centre).    
Since the colour used is the currently selected colour from the palette, it is suggested that 
an unused colour is used and the colour description changed to indicate a bead.

Return to What's new V5



What's New - Backstitchng
The old style of single stitch backstitching has been removed.    This is the only removal from
old versions.    The same effect can be achieved with backstitch lines but these are not 
limited to black.    The new automatic backstitch tool allows easier adding of backstitches 
without needing to select the appropriate tool for orientation.

Backstitch deleting is now easier as the right mouse key can be held down to continuously 
delete backstitches whilst moving the mouse.

Return to What's new V5



What's new - Text tool
The old Text Object tool has now been replaced with a more versatile Text Tool giving a 
choice of formats:

Object
This is the original tool that creates a resizeable text object from cross stitches.

Cross
This option simply creates the text from cross stitches but doesn't use an object. Although 
these cannot be edited later, they are more versatile as you can alter the result stitch by 
stitch.    This option will also use 3/4 stitches to smooth out the edges if the 3/4 stitch option 
is checked.

Back
This option will create text from Backstitches rather than cross stitch.    If used with the 
Diagonal backstitch option, the letters will look smoother.

Cross / Back
This option combines the Cross and Bacckstitch options to give lettering in Cross Stitch with 
outlining in black backstitch.

Return to What's New V5



What's new - Smoothing
In addition to the completely automatic smoothing of the Area Smooth command, there is 
also a manual smoothing tool.    When the mouse is clicked (or held down) over a stitch 
position, the program calculates if the design could be smoothed out by the addition of a 3/4
stitch.    If it can, a stitch of the appropriate colour and orientation is added.

By holding the mouse down and moving over the boundary between two colours, it is 
possible to smooth just that boundary.

Return to What's New V5



What's New - Thread Estimator
You can now select the number of strands used for stitching cross stitch and backstitch.    
The thread length required now take account of the number of strands and the 
backstitching.    Note that it is still only a guide since individual stitching technique will affect
the amount of thread used.

Return to What's New V5



What's new - File List
At the bottom of the File menu, the last 5 designs used will be displayed.    By selecting a file 
from this list, the file will be loaded without need to select from the file open dialog.    The list
is stored when the program terminates and reloaded next time it is run.

Return to What's New V5



What's    New - Manual Redraw
A new tool has been provided to allow a screen update to be forced.    The primary use of this
tool is to refresh the position of the center lines and the Width and Height display when they 
are used.    These features are no longer recalculated after each stitch addition in order to 
speed up the use of the program.

Return to What's new V5



What's New - Colour Names
The use of colour names and colour numbers are each selectable from the Palette Menu.    
There is no longer a need to provide a seperate colour range for named and unnamed 
colours.    All colour ranges should now be named and the names turned off when not 
required.

Return to What's New V5



What's New - Filenames
Also featured in the very last update of V4 is the use of long filenames.

By using SmatCode technology, the program determines what operating system is being 
used.    If it is a 32-bit operating system such as Windows 95 or NT Workstation then it calls 
32-bit routines.    If it is a 16-bit operating system such as Windows 3.1 or 3.11 or 
Workgroups then it calls 16-bit routines.

The advantage of SmartCode is that the same software can be run on 16 and 32 bit 
operating systems without any need to purchase upgrades in order to take advatage of the 
new features.    If the user is currently running Windows 3.1 and then upgrades to Windows 
95, the long filenames are automatically made available without even needing to re-install 
the software.

Return to What's new V5



What's new - INI file
The file XSPROF.INI is now maintained in the Windows directory and contains various 
parameters that are saved when the program exits and reloaded when it starts.    This file 
can also be edited with a standard text editor.

Currently the file stores the last 5 used files, the position and size of the main window and 
the size of the french knots on screen.



What's new - Export
Previous versions of the program would only export patterns to bmp format files.    Version 5 
allows several different formats and the choice is made by the file extension when giving the
filename for export.

The following formats are available for export:

BMP
TIF
GIF
PCX
WPG
JPG
MAC
Return to What's new V5



BMP
The BMP file format originates from Microsoft and is the standard image format used by 
Windows.    The bitmaps can be 1,4,8 or 24 bits uncompressed or 4 or 8 bits compressed.    
The 24 bit version has no palette.



TIFF
The TIFF format originates from Aldus and Microsoft and stands for Tagged Image Format 
File.    The image can be compressed in a variety of ways with a set of up to 45 tags being 
used to indicate the method used as well as image size,bits per pixel etc

Where the compression format allows multiple images to be compressed into a single file, 
only the first image will be read by XStitch Pro.



GIF
GIF (Graphics Interchange File format) originates from CompuServe. The bitmaps are 1,4or 8
bits giving a maximum of 256 colours.



PCX
The PCX file format originates from ZSoft Corporation and can be 1,4,8 or 24 bits in a simple 
run length encoded format.



WPG
The WGP format is the WordPerfect metafile format.    It supports up to 256 colours.

Only the raster information is read by XStitch Pro.



JPEG
JPEG originates from the Joint Photographic Experts Group and the files have the extension 
JPG.    The compression used in generating the file loses information so that the file size is 
reduced. Since information is lost, the restored picture is not exactly the same as the 
original.    There is a trade off between file size and picture quality.    This format is often used
to keep 24-bit images to a manageable size.    Uses 24 bits for colour or 8 bits for grey scale.



MAC Paint
MacPaint images are monochrome 720 X 576 pixels used on the Macintosh computers.



Menus
Click on a menu below for help on commands

File Menu
Zoom Menu
Area Menu
Palette Menu
Design Menu
Info Menu



File Menu
New
Open
Save
Saveas
Import
Scan
Scan Source
Autosave
Get Backup
Print
Printer Setup
Exit



File New
The File New command is used to clear the current design and start a new one.    If the 
current design has not been saved then a warning will be issued that all changes will be lost 
and the command may then be cancelled or accepted.

In order to save the current design first, use one of the save commands prior to File New.

See Also:
File Save
File Saveas



File Save
The save command is used to store the current design on disk.    The extension .XSP is 
normally used for all designs.    This is not essential but is recommended since these files are
listed automatically in the File Open dialogue boxes.    If an alternative is used it will have to 
be typed in manually.

If the file has previously been read from disk or has been saved before then it will already 
have a name and the updated design will overwrite the old one.

If the design is a new one then it will not have a name and one must be typed in when 
requested as with the Save As command.

Note that there is no warning if the name used already exists.    The new design will 
overwrite the old one.

If a filename other than the current name is required then use the Save As command.

See Also:
File Saveas



File Saveas
The Saveas command is used when the design must be written to a file other than the 
current name.    This allows both old and new designs to be saved.

Use this command to keep copies of the design at various stages in case a change of mind 
or a mistake occurs.

See Also:
File Save



File Open
The File Open Command is used to retrieve a design from disk.

A dialogue box is displayed showing all files with the .XSW extension in the current directory. 
An alternative directory may be chosen if required.

When a file has been selected, it is read from disk and displayed on the screen together with
the colour palette used to create it.

If the display is unable to exactly reproduce the colours in the original palette, the stitches 
will appear in the nearest available colour.    The palette may resemble the original colours 
more closely as large blocks of colour can be Dithered    whereas the stitches cannot.

Note that some colours may have the background as the closest available colour and hence 
appear invisible.    The stitches will still retain their original colour if saved back to disk and 
will therefore appear correct when viewed on a system with more colours.

Files from the original XStitch for Windows program with extension .XSW can be opened in 
the same way.    The format is automatically recognised and the design size adjusted to 
match that of the original program.



File Import
The File Import Command is used to convert graphics files to XStitch designs.

A dialogue box is displayed showing all files in the current directory.    An alternative 
directory may be chosen if required.    The program will determine the format of the graphics
file itself.

When a file has been selected, a dialogue box is displayed allowing the number of colours to 
be limited.    It is usually more successful to start with a file containing a limited number of 
colours but if this is not possible they can be limited here to prevent the pattern becoming 
too difficult to stitch.

The file is then read from disk , converted to XStitch format and displayed on the screen 
together with the new colour palette.

Each pixel in the bitmap file will be replaced with a single stitch in the XStitch design 
provided that the maximum design size is not exceeded.    
If the bitmap file exceeds the design size, it will be scaled down to the largest allowable size 
whilst maintaining the original aspect ratio. 

If the bitmap has to be scaled, some loss of detail may be caused which may not be 
acceptable.    It is therefore much better to start with a 
bitmap of the correct size than to let the program scale it during conversion.

One good use for the command is importing clip art (line drawings) which can then be 
coloured in with XStitch and combined with other pieces of clip art to produce a larger 
design.    This makes design easier for those less able to draw.    Clip art is readily available 
from many software companies and through shareware distributors.

Supported File Formats
See Also:
Bitmap Object Tool



Supported File Formats
The Following formats are supported by both the File Import command and the Bitmap 
Object tool:

PNG
BMP
DCX
EPS
GIF
JPEG
PCX
PICT
TARGA
TIFF
WMF
WPG
RLE
DIB
ICO
ATT G4
Brooktrout
Amiga IFF
Kodak Photo CD
Sun Raster
Microsoft Paint MSP
IOCA
MAC Paint
Photoshop
CALS
LaserData (LV)
Xbitmap (XBM)
Pixmap (XPM)
HALO Cut
G3
CLP
XWD
Kofax
Showpartner GX2
G4
ASCII



PNG
The PNG format is a new format introduced by CompuServe to replace GIF.    Whereas GIF 
contains patented algorithms which now require payment to the patent owners, PNG is 
freely available to everyone.



DCX
The DCX file type is a single file containing multiple PCX images.    XStitch pro will only read 
the first image from these files.



EPS
EPS (Postscript) files contain both vectors and bitmaps but usually also contain a TIFF format
screen preview.    XStitch Pro reads only the screen preview portion of the file.



PICT
The PCT format originates from Apple Computers and is the format used by the Macintosh 
computer.    The file can contain both vectors and bitmaps however XStitch Pro supports only
the bitmap portions of version 1 and version 2 files.



TARGA
The TARGA format originates from Truevision Inc. and has the file extension TGA.    Images 
can be 15 or 24 bit colour, 8 bit grey scale or simple run length encoded files.



WMF
The WMF format originates from Microsoft and is a metafile format.      Images can be 1,4,8, 
or 24 bits.

Only raster information is read by XStitch Pro.



RLE
RLE is the byte encoded form of the Sun Raster format.



DIB
The DIB (Device Independent Bitmap) is the format used in Windows from version 3.0 
onwards.    It consists of a header containing the width,height and bits per pixel followed by 
the packed image data.    A further file header is added to this format to create the BMP 
format.



ICO
The ICO format is used by Windows to store ICONS.    The format is a standard DIB format 
with a maximum of 16 colours.



ATT G4
A monochrome only format used mostly for fax transmission.



Brooktrout
A monochrome only format used mainly for FAX transmission.



Amiga IFF
Used by Commodore Amiga computers for storing a variety of data including images in up to
16.7 million colours.



Kodak Photo CD
The PCD format is used in Kodak's Photo CDs.    The images are stored in 24 bits per pixel at 
5 different resolutions.    XStitch Pro uses only the 768 X 512 resolution image.    This format 
is ideal for converting photos to cross stitch patterns since a film can be sent for processing 
and be returned with good quality scans without the need to purchase a scanner.



Sun Raster
The Sun Raster format is supported by SUN computers.    The data is 1,8,24 or 32 bits wide.    
The file extensions used include RAST, RAS, IM, IM8, IM24 and IM32 but there is no standard.



Microsoft Paint MSP
This format is monochrome only and is used by Microsoft Windows Paint.



IOCA
This is IBM's monochrome format supporting CCITT G3, CCITT G4 and mmmr formats.



Photoshop
Adobe Photoshop (PSD) is used for astronomical images and consists of a text header 
followed by the image data.    The format supports up to 16.8 million colours.



CALS
CALS (Computer-aided Acquisition and Logistics Support) files are monochrome only and FAX
group IV compressed. They are used by the US government.



LaserData LV
The LaserView format from LaserData is a monochrome only format.



Xbitmap XBM
The X Bitmap format is monochrome only and consists of lines of text that are also valid C 
source code.



Pixmap XPM
The XPM format is a colour version of XBM.    This format also represents the image data by 
lines of text that also comprise legal C source code.



HALO Cut
The CUT format is 8 bits per pixel (256 colour) and is used by a variety of different MSDOS 
paint packages.



G3
The group 3 FAX format is monochrome only.



CLP
The format used by the Windows clipboard.



XWD
A monochrome only format.



Kofax
A monochrome only format.



Showpartner GX2
A 4 or 8 bit per pixel raster format.



G4
The group 4 FAX format.



ASCII
The ASCII (Text) format is included for completeness.    Whilst the program will read and 
convert text files, it is probably better to use the text object function since this gives the 
ability to edit the text later.



Bitmap Object Tool

The bitmap tool allows a graphics file to be imported as an abject on the current design.    
This means that the resulting stitches can be moved around the design as a single object 
without destroying any existing stitches which it passes over.

The advantages of the bitmap object are that each design object can be placed onto the 
design and then moved around and resized until the design looks right.

When the file is imported, the colours are matched to the existing palette rather than 
changing the palette to suit the imported file.    This prevents changes to existing stitches 
and other bitmap objects but means that it is necessary for the designer to ensure the 
palette contains suitable colours.    Each colour can of course be changed later but if two 
colours both result in the same nearest colour then the distinction between them will be lost.

To import a bitmap file, click the left mouse button on the design where the top left corner of
the object is to be placed.

A dialogue will appear enabling the filename to be selected.    The file will then be translated 
to cross stitch format and the colours will be matched to the existing palette.

Supported File Formats
See Also:
Deleting a Bitmap Object
Selecting a Bitmap Object
Rescaling a Bitmap Object
Moving a Bitmap Object



Deleting a Bitmap Object
To delete a Bitmap object, simply select the Bitmap Object tool and click the right hand 
mouse key with the pointer over the object to be deleted.

See Also:
Adding a Bitmap Object
Selecting a Bitmap Object
Rescaling a Bitmap Object
Moving a Bitmap Object



Selecting a Bitmap Object
A Bitmap Object must normally be selected in order to be moved or resized.    To select a 
Bitmap Object, choose the Select tool from the Tool Palette and click the left mouse button 
over the object.

When Selected, the Bitmap Object will be surrounded by a black box.    The corners of this 
box may be dragged to change the size of the object.

See Also:
Adding a Bitmap Object
Deleting a Bitmap Object
Rescaling a Bitmap Object
Moving a Bitmap Object



Rescaling a Bitmap Object
To resize a Bitmap Object, first select the object using the Select Tool.

 
Next, move the mouse pointer over the corner of the objects box until it changes to the 
double arrow pointer.    Hold down the left mouse button and move the mouse until the box 
reaches the desired size.    When the mouse is released, the object will be resized to fit the 
new box.

See Also:
Adding a Bitmap Object
Deleting a Bitmap Object
Selecting a Bitmap Object
Moving a Bitmap Object



Moving a Bitmap Object
To move a bitmap object, use the Select Tool.

 
Hold the left mouse button down over the object and drag it to the new position.    There may
be a slight delay before it starts moving on slower machines but speed should improve after 
the first move.

Where objects are placed on top of one another, the last object to be imported will appear 
on top.

See Also:
Adding a Bitmap Object
Deleting a Bitmap Object
Selecting a Bitmap Object
Rescaling a Bitmap Object



File Scan
The Scan command from the File menu calls the TWAIN compliant scanner driver.    This 
allows you to scan in a photograph and convert directly to a cross stitch pattern.    The same 
colour reduction algorithms are used as for the File Import function.

To select the source for the scan when there are multiple TWAIN devices installed, use the 
Scan Source command.



File Scan Source
The Scan Source command from the File menu is only used when multiple TWAIN compliant 
devices are installed.    It allows the desired device to be chosen from those available.    Each 
Scan command will use the device that was last chosen with this command.



File Autosave
The autosave command enables the design to be saved at set intervals in order that the 
entire design is not lost if there is a system crash, power failure or if a mistake is made.

When the autosave command is selected from the File menu, a dialogue box is displayed 
where the time period can be entered.    A value of 0 will dissable the function.

The autosave function saves the design to the file XSPRO.SAV

To recall the old design, select the Get Backup command from the File menu.

See Also
File Open
File Save
File Saveas



File Get Backup
The Get Backup command from the File menu retrieves the last backup copy that was saved 
by the Autosave function.    Note that the Autosave function must first be enabled by 
selecting it from the menu and entering the time between backups.



File Print
The File Print command prints the current design on the selected printer.    
Before printing, a dialogue box is displayed allowing various print parameters to be selected.
The parameters that may be set are arranged as pages in a notebook.    Each page is listed 
below. Click on the name of the page for further information.

An alternative printer may be selected with the Printer Setup command which also allows 
the setting of other print parameters such as page size and orientation.

The Title of the design and name of the designer may also be entered.    These are not only 
available to print out but are also stored when the pattern is saved.

Select a page heading for more information
Area
Key
Scales
Format
Options
Margins



Print Area
The print area page of the print dialog enables a specific area of the design to be printed as 
follows:

AutoCrop
AutoCrop automatically eliminates any large unused areas to the top,bottom,left and right of
the design.    The area printed will always start and end on a large (10 grids by default) 
square.    This is the most frequently used option.

All
The All option will print the entire design area no matter how large or small an area is used. 
This setting is useful in checking what scale a full size design will need to be printed at to be 
readable on a particular printer.

Key Only
Allow the key to be printed on its own.    This is a quick way to see the colours used in a 
design.

Manual
Manual allows the minimum and maximum X and Y values to be entered for precise control 
of the printed area.    Move the mouse to the corners of the required area and read off the 
coordinates from the XY readout window.    The minimum and maximum values will be 
swapped automatically if they are accidentally entered in reverse.

Page number to print
By default, this is set to 0 and causes all the pages to print.    Setting any other number will 
print just that page.

Stitches per Inch
This parameter determines the size of the printout.    As the number of stitches per inch is 
changed, the readout of the total number of pages is updated accordingly.    If a value of zero
is specified, the older method of scaling used in previous versions of the program is used.



Print Key
The key prints each symbol type along with its text description which is entered in the colour
change box.

The Key can either be printed on each sheet (the default) or can be printed on a separate 
sheet at the end of the design.

If colour printout is selected then the key will be in colour, otherwise, it will show symbols.

There is also a Key Only option which will print just the colour key.

For large designs, the key should always be printed on a seperate sheet or the area taken by
the key will not leave very much room for the design.

A Font button allows the text font used to be changed.



Print Scale
The Scale page of the print dialog allows the default scaling to be changed for various parts 
of the design:

Design
This parameter is not used unless the Stitches per inch setting on the Area tab is set to zero. 
If this is the case , the old method of print scaling used in previous versions of the program 
is used.

Symbol
The size of the symbols used can also be changed.    The entered size is expressed as a 
percentage of the grid size.    A size of 100% will fill the grid position and allow the symbol to 
run into the grid.    A size of around 80% gives a good result and is the default.

Backstitch Line Width
The width of the freehand backstitch lines is set to 20% of the grid size by default.    This can
be altered as desired.

Backstitch Width
The vertical, horizontal and diagonal backstitches with single stitch length are printed with a 
seperately configurable thickness.    They are also set to 20% of grid size by default.

Major Grid Thickness
The thickness of line used to draw the grid at a major interval.    The major interval is 10 
stitches by default but follows the value set for the main design screen.    The colour of the 
line is also selectable.

Minor Grid Thickness
The thickness of line used to draw the grid for each line not on a major interval.    The colour 
of the line is also selectable.



Print Format
The printout can be configured to a number of different formats:

Black & White Symbols
Each stitch is represented by the chosen symbol in black.

Colour Symbols
Each stitch is represented by the chosen symbol but the colour of the symbol is also the 
colour of the thread it represents.

Colour Blocks
Each grid position is filled with the colour of the thread it represents.

Colour Blocks with Symbols
Each grid position is filled with the colour of the thread it reppresents.    In addition, the black
symbol for that colour is placed on top.

Colour Blocks with Symbols on White Background
A combination of Black and White Symbols but edged with the appropriate colour.    This is 
easier to read than the Colour Blocks with Symbols if the colours are dark.



Print Options
The Print Options page of the print dialog allows a number of different objects to be added to
the printed page:

Center marks
Selected by default, this adds markers at each edge of the pattern to indicate the center of 
the used design area.

Grid
The grid is normally printed but may be turned off if desired.    This could be used to print 
colour blocks onto a release paper that can be ironed onto fabric.

Page numbers
Page numbers are normally printed to aid in the assembly of multi-page designs however 
they may be turned off if not wanted.

Title
The title may be printed on all pages, just page 1 or not at all.

Designer
The designers name may be printed on all pages, just page 1 or not at all.    This could be 
used to add a copyright notice.

Notes
It is possible to print the design notes attached to the pattern. These would normally be 
written from the main program screen but a button is included to allow last minute editing.

Print each page as seperate print job
This option is used to print large multi-page patterns when there is not enough memory or 
hard disk space to do so all at once.    Instead of creating a print file containing all pages and 
then printing it, a seperate print file is created for each page.    If the print manager is turned
off, the program waits for each page to be printed and its associated temporary file to be 
deleted prior to moving on to the next page.



Print Margins
A value for the Top,Bottom,Left and right margins may be entered into the relevant edit 
boxes.    This will cause an additional blank area to be left around the design.    The values 
are in pixels and are in addition to any unprintable area of the sheet of paper.

If a key has been selected on each page, it will further reduce the size available for printing 
the design and the selected bottom margin will appear below the key.

If no additional margins are required, the boxes may be left blank.

This facility is particularly useful where a poorly written printer driver does not properly 
report the unprintable area of the page.    This would normally result in part of the design 
being missed off the printout but is easily corrected by adding a margin to the appropriate 
edge.    Fortunately, this is not very common in modern drivers.



File Printer Setup
The Printer Setup command is used to select a printer from a list of currently installed 
printers.

The setup function of the printer driver may also be accessed from this command allowing 
the setting of various print parameters such as paper size and orientation.

Colour printers are supported for both colour block printouts and monochrome symbol 
printouts.    Printing may be considerably faster if the printer is set up for monochrome 
output depending on the printer type and the installed print driver.

If your printer is not listed then it is not currently installed for use by windows.    Consult the 
windows manual for instructions on installing new 
printers. 



File Exit
The Exit command causes the program to terminate.

If the current design has been changed and is not saved then a prompt will be made to allow
the operation to be aborted.

If the warning is ignored then the current design changes will be lost and the program will 
terminate.



Zoom Menu
The Zoom menu includes commands that enable you to select the screen magnification.

The default magnification is 300%.

Magnifications between 100% and 1200% may be selected.

The currently selected magnification is identified on the menu by a tick to the left of the 
value.

The two zoom buttons on the toolbar can also be used to move up and down by one level.



Area Menu
Define
Cut
Copy
Paste
Delete
Fill
Rotate90
ReflectX
ReflectY
Mirror
To Object
Auto Backstitch
Auto Smooth
Swap Colour
Open Shape
Filled Shape



Area Define

An Area must be defined in order to use an area Command.

To define an area, select the Area Define tool and click the left mouse button on the stitch at 
the top left of the required area.

With the mouse button still pressed, drag the mouse to the bottom right corner of the area 
and release the button.    The defined area will now be shown outlined in black.

Clicking and releasing the mouse button at the same location will result in an area of just 
one stitch being defined.    A one stitch area may be used for the Area Paste command since 
only the top left corner needs to be defined.    The remaining dimensions are determined by 
the size of the area in the buffer.

See Also:
Area Cut
Area Copy
Area Paste
Area Delete
Area Fill
Area Rotate
Area Reflect X
Area Reflect Y
Area Mirror



Cut
The Area Cut command is identical to the Area Copy command but in addition to placing the 
stitches in a buffer,. the original stitches are erased.

This command is often used in conjunction with the Area Paste command to move groups of 
stitches from one place on a drawing to another.    It may also be used to move stitches from 
one drawing to another since the buffer. is not erased when loading in a new file.

See Also:
Area Define
Area Copy
Area Paste
Area Delete
Area Fill
Area Rotate
Area Reflect X
Area Reflect Y
Area Mirror



Copy
The Area Copy command is used to copy an area of stitches which has previously been 
defined with the Area Define command.

The stitches are copied to an internal buffer. and can then be placed at another point on the 
drawing by using the Area Paste command.    Area paste can be executed any number of 
times with the same stitches since the buffer. is only erased by another Area Copy command
or a Area Cut command.

This command works on cross stitches, half stitches and backstitches.    Backstitch lines and 
objects are ignored.. 

If the destination area is not blank then any existing stitches will be erased.    Existing 
backstitches will be unaffected.

See Also:
Area Define
Area Cut
Area Paste
Area Delete
Area Fill
Area Rotate
Area Reflect X
Area Reflect Y
Area Mirror



Paste
Copies all stitches in the buffer to the design starting at the top left corner of the defined 
area.

See Also:
Area Define
Area Copy
Area Delete
Area Fill
Area Rotate
Area Reflect X
Area Reflect Y
Area Mirror



Delete
The Area Delete command is used to delete all types of stitches in the defined area. The 
stitches are NOT stored in the buffer and the current contents of the buffer is retained.

To delete stitches but copy them to the buffer for later use, the Area Cut command should be
used.

See Also:
Area Define
Area Cut
Area Paste
Area Fill
Area Rotate
Area Reflect X
Area Reflect Y
Area Mirror



Fill
Fills the currently defined area with the currently selected stitch type and colour.

See Also:
Area Define
Area Copy
Area Paste
Area Delete
Area Rotate
Area Reflect X
Area Reflect Y
Area Mirror



Rotate
Takes all stitches in the defined area and rotates about the top left corner of the area.

The resulting area replaces the original stitches.

If the area is not square then some stitches outside the original area will be replaced while 
others inside the area remain unchanged.    The top left corner of the new area always maps 
to the top left corner of the defined area.

See Also:
Area Define
Area Cut
Area Paste
Area Delete
Area Fill
Area Reflect X
Area Reflect Y
Area Mirror



ReflectX
Takes all stitches in the defined area and reflects them about the centre of the area in the X-
axis.    The resulting stitches replace the original area.

See Also:
Area Define
Area Copy
Area Paste
Area Delete
Area Fill
Area Rotate
Area Reflect Y
Area Mirror



ReflectY
Takes all stitches in the defined area and reflects them about the centre of the area in the Y-
axis.    The resulting stitches replace the original area.

See Also:
Area Define
Area Copy
Area Paste
Area Delete
Area Fill
Area Rotate
Area Reflect X
Area Mirror



Area Mirror
Replaces the selected area with a mirror image of the original.

See Also:
Area Define
Area Cut
Area Paste
Area Delete
Area Fill
Area Rotate
Area Reflect X
Area Reflect Y



To Object
The To_Object command converts the currently selected area of stitches and converts it to a 
Bitmap Object.    The appearance on the screen and the printed pattern will remain identical 
but now the Select tool can be used to move the object around the screen or to resize it.

To convert the object back to stitches, double click on it with the select tool.

Only full cross stitches will be converted, any half stitches or backstitches will remain as 
single stitches on the pattern.

See Also:
Bitmap Objects
Object Select Tool
Moving a Bitmap Object
Rescaling a Bitmap Object



Bitmap Objects
A Bitmap Object is a collection of stitches which has been created directly from a graphics 
file.    Although at first this may seem the same as using the File Import function, there is a 
big difference.    A Bitmap Object retains the connection between the individual stitches and 
may be moved around the design as if it were a single object.    A bitmap object may also be 
rescaled at any time and can be converted to individual stitches when its size and position 
have been finalised.

Bitmap Objects may also be created by selecting a block of stitches with the Block Define 
tool and then converting them to an object by the To Object function on the Block menu.

Adding a Bitmap Object
Deleting a Bitmap Object
Selecting a Bitmap Object
Rescaling a Bitmap Object
Moving a Bitmap Object
Converting to stitches





Object Select Tool

The select tool is used to select an existing object.    This can either be a text object a bitmap
object.

Once the object is selected, it is surrounded by a black box.    This box can be used to resize 
the object by dragging one of the corners to a new location.    Once a text object has been 
selected, double clicking on it will bring up the original dialogue, allowing the text or font to 
be changed.    The colour of a selected text 
object can also be changed by clicking on a new colour from the palette.

To select an object, simply click the left mouse button anywhere on the object.



Auto_Backstitch
The Auto Backstitch tool is located on the Area menu and is also available on the toolbar.

This tool operates only within the currently selected area.

Any changes in colour will automatically be outlined in backstitch of the currently selected 
colour.    Outlining will take account of 3/4 stitches by using a diagonal line.

This tool can save a lot of time but is not intended for complex graphical imports where 
there are likely to be many subtle changes of shade.    Under these circumstances, it will 
produce too much backstitching.

The backstitching produced is exactly the same as that added with the standard backstitch 
line tool so it can be erase in the normal way.



Auto Smooth
The Auto Smooth command is located on the area menu.

It adds 3/4 stitches in appropriate colours to any stitching in the currently selected area that 
has jagged edges.

Whilst this step could be done by adding the stitches one by one, this tool saves a lot of 
time.



Swap Colour
The swap colour command is located on the Area menu.    Since this tool requires mouse 
clicks on both design and colour palette, a yellow hint window is used to guide you through 
the steps:

Step 1 - Select the Area
First select the area in which the colour is to be swapped using the Area Select tool.

Step 2 - Select the Swap Colour Tool
When the Swap Colour tool is selected, a yellow hint window appears.

Step 3 - Select the colour to change
The hint window instructs you to click on a stitch in the design.    It is the colour of this stitch 
that will be replaced with a new colour.    Only stitches of this colour in the selected area will 
be affected.    Any stitches of this colour outside the area will remain unchanged.

Step 4 - select the new colour
The hint window changes to instruct you to select a new colour.    Scroll the palette window 
at the left of the screen until you find the colour you want.    When you click on the new 
colour, the colour swap is performed.



Area Open Shape
The Open Shape item on the Area menu is used to create circles, squares, ellipses, 
rectangles and rectangles with rounded corners.    The shape is drawn within the currently 
selected area.    The line width will be the currently selected pen width.

When the menu item is selected, a secondary menu is displayed to allow the shape to be 
chosen.

Circle
If the selected area is perfectly square then a circle will be drawn which touches all 
boundaries of the area.    If the selected area is not square then the result will be an ellipse.

Rectangle
A rectangle is drawn which touches all sides of the selected area.    If the selected area is 
perfectly square then the result is a square

Rounded Rectangle
This results in the same shape as the rectangle function except that the four corners are 
rounded off.

See Also:
The inside of an open shape will remain as it was prior to adding the shape.    For a filled 
result, see the Block Filled Shape command.



Area Filled Shape
The Filled Shape item on the Area menu is used to create circles, squares, ellipses, 
rectangles and rectangles with rounded corners.    The shape is drawn within the currently 
selected area and filled with stitches.

When the menu item is selected, a secondary menu is displayed to allow the shape to be 
chosen.

Circle
If the selected area is perfectly square then a circle will be drawn which touches all 
boundaries of the area.    If the selected area is not square then the result will be an ellipse.

Rectangle
A rectangle is drawn which touches all sides of the selected area.    If the selected area is 
perfectly square then the result is a square

Rounded Rectangle
This results in the same shape as the rectangle function except that the four corners are 
rounded off.

See Also:
The inside of a filled shape will be filled with the currently selected colour.    For an unfilled 
result, see the Block Open Shape command.



Palette Menu
The Palette menu includes commands that enable you to change the colours used in the 
design and the colour ranges that are available.

For more information, select a Palette menu command name below:

Colour Change
Colour Swap
Remove Duplicates
Edit colour ranges
Match Colours
New entries



Colour Change
The palette is modified by selecting the colour with the right mouse button instead of the 
left (delete in place of insert with the keyboard) or by selecting the Colour change option 
from the palette menu.    A window containing 3 scroll bars then appears one each for Red, 
Green and blue.    By moving the scroll bars, the amount of each primary colour can be 
altered and hence any colour can be selected.

As the colour is changed, the palette will change to display the new colour.    On systems 
which support a hardware palette (e.g. 256 colour VGA) the stitches in the design will also 
change as the scroll bars move.    

On systems which do not support a hardware palette, the design will be redrawn with the 
new colours when the scrollbar window is closed.

Any number of colours may be modified without re-selecting the command by using the left 
mouse button to select the next colour.    The position of the scroll bars will then change to 
reflect the new colour.

The scrollbar window is closed by selecting a colour with the right mouse button or by 
pressing the escape key on the keyboard (Esc).

Choosing a new DMC colour
Creating a custom colour and choosing the nearest DMC colour

See Also:
Choosing a new DMC colour
Creating a custom colour and choosing the nearest DMC colour
Colour Swap



Choosing a new DMC colour
To substitute a new DMC colour for a palette entry, simply double click on the palette entry 
or select the Colour Swap option from the palette menu.    This will produce a window 
containing all the available DMC colours.    If the left mouse button is held down,as the 
mouse is moved over each colour, the pattern display will update to show the effect of 
substituting that colour.    When the mouse button is released, or if a single click is made, the
colour will remain selected.    When the final colour choice is made, click on the OK button to 
remove the window.

Note that on non-palette displays, the screen will not be updated automatically, however an 
update button will appear allowing the screen to be updated at any time.

If there are more DMC colours than there are colours available for display then some colours 
will be shown dithered which is unavoidable.

See Also:
Creating a custom colour
Creating a custom colour and choosing the nearest DMC colour



Creating a custom colour
Custom colours can be created by the same procedure as coosing a new DMC colour.    
Instead of accepting one of the predefined colours, simply move the scrollers to vary the 
amount of red, green and blue and then type in a new name for the colour.

Colours chosen in this way are only kept whilst the program is running and in any patterns 
that are saved.    If the program is restarted, the colours can only be recovered by loading a 
previously saved pattern.    To create new colours that are permanently available, use the 
Colour Editor.

See Also:
Choosing a new DMC colour
Creating a custom colour and choosing the nearest DMC colour



Creating a custom colour and 
choosing the nearest DMC colour
The easiest way of creating a colour from the scrollers and then finding the nearest DMC (or 
other range) colour is to first create all your custom colours and then select the match 
colours function from the palette menu.



Colour Swap
To substitute a new DMC colour for a palette entry, simply double click on the palette entry 
or select the Colour Swap option from the palette menu.    This will produce a window 
containing all the available DMC colours.    As the mouse is moved over each colour, the 
pattern display will update to show the effect of 
substituting that colour.    When the mouse is clicked over a colour, the substitution will be 
made.

In 256 colour mode, the updating of the display should be instant, however in other modes, 
there may be some delay.    In order to minimise delays, the mouse pointer should be moved 
quickly to the required colour.    There is no need to wait for the display to update before 
moving to the next colour.

If there are more DMC colours than there are colours available for display then some colours 
will be shown dithered which is unavoidable.

See Also:
Creating a custom colour
Creating a custom colour and choosing the nearest DMC colour



Remove Duplicates
The remove Duplicates command can be found on the palette menu.    It is used to combine 
different palette entries which define the same colour.

Sometimes, the importing of a graphics file will result in several colours mapping to the 
same nearest DMC colour.    Since the original colours were slightly different, the program 
does not assign the same palette entry.    This enables each colour to be changed separately 
if desired.    When all changes are made, the Remove Duplicate command should be used so 
that the finished pattern does not repeat any colours in the colour key.

Note colours are assumed to be duplicates when their red,green and blue components are 
identical regardless of the colour descriptions.



Edit colour ranges
This command is used to alter the master colour range information.    Any changes made will
affect all patterns created in the future so it is recommended that the file XSPRO.CLR is 
backup up before changes are made.

The colour editor displays a list box containing the name of each thread range available.    
Simply click on the name of the range to modify.

Once a range is selected, each colour is displayed on the right hand side and is split into 3 
pages.    To view more of the colours, click on the tab of the required page.

To modify a colour, click on it with the left mouse button and the colour will then be shown in
the sample patch near the bottom of the screen.    The three slider controls may now be used
to modify the red, green and blue components of the colour.

The name of the colour being changed is displayed in the name edit box.    This name can be
changed and is the name that appears in the colour key of the final pattern when it is 
printed.

To aid in selecting the correct colour, the title bar of the editors window shows which colour 
the mouse pointer is currently over.

Colours may be added and deleted from the range by clicking on the appropriate buttons 
beneath the colour pages.

Complete new ranges can be added and existing ranges deleted or renamed by using the 
buttons at the left of the screen.

To save the changes, select the OK button.    To discard any changes, select the cancel 
button.

If the mouse pointer is left over an object for any length of time, a hint box is displayed to 
show the use of that object.

Users are encouraged to submit any ranges they add to the author for inclusion in the next 
release.    This helps build up a wide range of thread colours and ensures that any added 
colours do not have to be re-entered when upgrading to a later version.



Palette Match Colours
The match colours command from the palette menu will change each colour in the palette 
for the nearest colour in the selected range.



New entries in Palette Menu
If the colour ranges data file is updated at a later date, the program will automatically add 
extra menu items to the Palette menu in order that the user can change the range in use.    
At the time of writing,    DMC and Anchor ranges are available so there are two further 
entries on the menu.    Selecting a new range will cause each colour in the palette to change 
to the nearest equivalent in the new range.

To mix colours from different ranges, a single colour can be selected in the palette and 
changed to any available range using the colour change command.    The colour change 
window will show a new entry in the list for each range available.

The colour range information is stored in the file XSPRO.CLR and can be changed by the user
only by using the Edit Colour Ranges command from the palette menu.    Users are 
encouraged to submit any ranges they add to the author for inclusion in the next release.    
This helps build up a wide range of thread colours and ensures that any added colours do 
not have to be re-entered when upgrading to a later version.

The author welcomes comments on the accuracy or otherwise of any colours in the ranges.

See also:
+Mono entries



Mono Entries
Colour ranges ending in +Mono are identical to those of the same name without the +Mono 
but have additional shades of grey added.    These grey entries do not represent real thread 
colours but help when importing black and white scanned images.

To import a black and white image, follow the following steps:

1) Select a colour range including the +Mono extensions.

2) Import the graphics file or scan the image if using a scanner.

3) Use the colour swap function to change each grey into a colour.

4) Select the same colour range but without the +Mono extensions.

Tip:
Start the colour swap function by double clicking on the first colour in the palette but after 
selecting the correct colour, do not select the OK button.    Instead, click on the next colour in
the palette and repeat for all colours.    Now click the OK button to accept all the changes 
and close the swap window.    This is faster than having to redraw the swap window after 
each colour change.



Design Menu
The Design menu allows the selection of the graphics display mode (cross/block), the 
visibility of the grid and centre marks, and the changing of the design size.

For more information, select a Design menu command name below:

Blocks
Crosses
Symbols
Symbols & Blocks
Colour Symbols
Grid Display
Grid Interval
Centre Marks
Aspect Ratio
A-H
Custom



Design Blocks
The Blocks command from the Design menu causes each stitch in the design to be shown as
a solid block rather than a cross shape. 

See Also:
Design Crosses
Design Grid
Design Center Marks
Design Size A-H



Design Crosses
The Crosses command from the design menu causes each stitch in the design to be 
represented by a cross shape rather than a solid block.

See Also:
Design Blocks
Design Grid
Design Center Marks
Design Size A-H



Design Grid Display
The Grid Display command from the Design menu toggles the display of the grid on and off.  
When the grid is on, there is a tick mark displayed on the menu.    The printout is not 
affected by this command.

See also:
Design Blocks
Design Crosses
Design Center Marks
Design Size A-H



Design Centre Marks
The Centre Marks command from the Design menu toggles the display of the centre lines on 
and off.    
The centre lines mark the centre of the stitches currently on the design and are updated 
each time a stitch is added except when the mouse is held down.    In this case, the position 
of the marks is updated when the mouse button is released.

See Also:
Design Blocks
Design Crosses
Design Grid
Design Size A-H



Design Size A-H
The commands A thru H from the Design menu allow the size of the current design to be 
changed.    If the size of the new design is smaller than the currently entered design then 
some stitches will be lost.    If the new size is larger than the current design then the size is 
increased without affecting the existing stitches.

The custom size option allows any design size up to the maximum 1200 x 1200 to be used 
by entering the required width and height.

See Also:
Design Blocks
Design Crosses
Design Grid
Design Center Marks



Design Symbols
The Symbols command from the Design menu causes each stitch in the design to be shown 
as a symbol rather than a cross shape.    The symbols used are those which will appear in the
printout so this mode gives a good indication of how a symbol printout will look.    Due to the 
limited resolution of a screen compared with the printout, it may be necessary to zoom in to 
a high level to see the symbols clearly.



Symbols and Blocks
The Symbols & Blocks command from the Design menu causes each stitch in the design to 
be shown as a symbol with a coloured background rather than a cross shape.    The symbols 
used are those which will appear in the printout so this mode gives a good indication of how 
a symbol printout will look but also shows the correct colour.    Due to the limited resolution 
of a screen compared with the printout, it may be necessary to zoom in to a high level to see
the symbols clearly.



Colour Symbols
The Colour Symbols command from the Design menu causes each stitch in the design to be 
shown as a symbol but with the colour of the thread intead of black. The symbols used are 
those which will appear in the printout so this mode gives a good indication of how a symbol
printout will look but also shows the correct colour.    Due to the limited resolution of a screen
compared with the printout, it may be necessary to zoom in to a high level to see the 
symbols clearly.



Design Grid Interval
The Grid Interval command from the Design menu allows the setting of the major grid 
interval.    This is the number of squares between each dark grid line.    If this is set to the HPI
(or TPI) of the material being used, each large square will represent one inch.

The default setting is 10 squares which allows easy counting.

The printed grid will appear in the same way.

See also:
Grid Display



Aspect Ratio
For Cross Stitch, the aspect ratio of the grid needs to be 1:1 (square) however for designing 
patterns where the stitches are not square, the aspect ratio of the grid may be altered.    This
is commonly required in Duplicate Stitch.

The numbers entered must be whole numbers, the first representing the    X size and the 
second the relative Y size.

The grid should have the same aspect ratio as a stitch on the intended material if any design
is to look correct when stitched.    Note that the pattern will be printed on a square grid and 
will thus look different to the final stitched article.



Custom Size
The Custom Size option from the Palette menu is used to select a design size other than the 
predefined ones listed.    Any X and Y size can be used up to the maximum 1200.



Info Menu
The Info menu allows the window displaying the current stitch position to be turned on and 
off. It also allows the width and height of the current design to be displayed and gives access
to a design size calculator.

For more information, select an XYPOS menu command name below:

Show WH
Sizes



Show WH
The Show WH command from the Info menu is used to toggle on and off the display of 
pattern width and height.

The width and height displayed are that of the used pattern area not simply the selected 
design size.    This requires the values to be calculated after each addition or deletion of the 
pattern which is time consuming.    It is for this reason that the display of width and height is 
turned off by default.

The display may also be toggled on and off by clicking inside the display area itself.



Sizes
The Info_Sizes command displays a dialogue box of pattern information.

A value may be entered for material HPI, Width or Height and calculated values for all three 
will be displayed.      Values may be entered in inches or cm by clicking on the appropriate 
unit button.

If the Auto Crop button is set then the pattern will extend to the next nearest dark grid line.   
Otherwise the exact size will be used.    The number of stitches in X and Y directions is 
displayed in brackets underneath each of the choices.

Specifying HPI
If an HPI value is entered, the width and height will be calculated and displayed.

Specifying by Width
If a width is entered then the HPI is first calculated such that the pattern width is equal to or 
less than the value entered.    The resulting width and height are then calculated and 
displayed.    The width may not be exactly equal to the entered value since the HPI must be a
whole number.

Specifying by Height
If a height is entered then the HPI is first calculated such that the pattern height is equal to 
or less than the value entered.    The resulting width and height are then calculated and 
displayed.    The height may not be exactly equal to the entered value since the HPI must be 
a whole number.

Changing Units
The units may be changed between centimetres and inches at any time.    If a width or 
height was the 
last thing entered then the entered value will be assumed to be in the new units and a 
recalculation will 
result.    If an HPI was the last thing entered then the calculated values will be converted to 
the new units.

Threads



Threads
The threads button on the Sizes dialog displays a list of thread colours used, the number of 
stitches used for each colour and an estimate of the number of skeins required.

The information is displayed in a text editor to allow it to be modified before being printed.    
It can also be sent to the windows clipboard so that it can be pasted into other applications.

Note that any modifications are not kept once the dialog is closed so they should be printed 
or pasted to another application and saved first.



How to Purchase
The full version of Cross Stitch Professional for Windows V5 is available direct from the 
author in the UK or via the CompuServe Information Service.    Please note that once the full 
version has been despatched, it cannot be returned - please use the demonstration for 
evaluation.

To order via CompuServe:
CompuServe users may purchase online by using GO SWREG and following the instructions 
to register by program ID.    The ID number is 12836.    The program will then be despatched 
to you by first class post within the UK or by Airmail elsewhere. In addition, a short email will
enable your demo to operate as the full version until the package arrives.    The cost of the 
package is added to your CompuServe bill.

For upgrades from V4.x, use program ID 12837

To order by post:
Send a cheque (check in USA) made payable to D. Peters to the following address:

25 Warren Close
Bradley Stoke
Bristol
BS12 0BP
ENGLAND

Prices for Version 5:
Via CompuServe registration:    190 US Dollars      +    5 dollars Shipping

Via Post within the UK:                    124 Pounds Stirling post free

Via Post outside the UK:                190 US Dollars    + 5 Dollars Shipping

Prices for Upgrades from version 4:
Via CompuServe registration:      40 US Dollars    +    10 Dollars Shipping

Via Post within the UK:                      30 Pounds Stirling including postage

Via Post outside the UK:                  40 US Dollars    + 10 Dollars Shipping

Foriegn Currencies:
Payment can be made in any currency.    For other currencies, take the US Dollar price and 
use the exchange rate at date of ordering or telephone for a quotation.

Technical Support and Further Information:
Post:    At the address above.

Telephone:    (0850 846919)        or    (01454 612598)

CompuServe:    100102,1724

AOL:    XSProf

e-mail:    100102.1724@compuserve.com



WorldWide Web:    http://home.aol.com/xsprof



Adding Stitches
Stitches can be added by painting with the mouse but by using the keyboard    in conjunction
with the mouse, it is easier to draw straight lines.

Adding Stitches with the Mouse
Adding Stitches with Mouse and Keyboard



Adding Stitches with the Mouse
1/    Select a colour by clicking the left button with the mouse pointer over the required 
colour of the colour palette.

2/    Select the type of stitch by clicking the left mouse button with the mouse pointer over 
the icon representing the required stitch.

3/    Click the left mouse button with the mouse pointer over the position where the stitch is 
required.

By moving the mouse whilst holding down the left button, consecutive stitches can be drawn
without repeatedly pressing the mouse button.    In this way, the mouse can be used like a 
paintbrush.

Stitches are deleted in the same way using the right mouse button.

It is suggested that colours be used from the top left of the palette first.    To select a new 
colour for the first colour, double click on the first colour and select from the range that is 
then displayed.    Note that the white colour at the far top left is the background colour.    For 
each new colour, double click on the next colour and choose from the range.    This is easier 
than searching the palette for the colour required and also gives access to ALL the available 
colours not just the 220 in the palette.

See Also:
Adding Stitches with Mouse and Keyboard



Adding Stitches with Mouse and 
Keyboard
The mouse and keyboard commands can be mixed freely at any time, so holding down the 
left button of the mouse and using the cursor keys will draw perfectly straight lines.

Equally, holding down the right mouse key and using the cursor keys will erase in a perfectly
straight line.

If the system cannot keep up with the auto repeat    (stitches are missed ) then the auto 
repeat speed should be reduced using the Keyboard functions of the Windows Control Panel.

See Also:
Adding Stitches with the Mouse



Backstitch Line

The backstitch line tool allows backstitch lines to be added between any two points on the 
design at any angle.    It also enables backstitches to be added in any colour.

First select the colour to be used.

Secondly, click and hold down the left mouse button at the start of the line to be drawn.

Move the mouse to the end of the line to be drawn and release it.

To erase a backstitch line, use the right mouse button anywhere on the line.

See Also:
Auto Backstitch



Text Object Tool

The text tool is used to add letters and numbers to the design without having to work out 
the arrangement of stitches for each character.    It allows the text to be typed at the 
keyboard and determines the layout of stitches by matching them to a chosen Truetype font.

To add text, choose a colour then click the left mouse button at the point where the text is to
start.

A dialogue box will appear into which the required text can be typed.

To change the font used from the default or to choose a different size, click on the Fonts 
button.

Once the text and fonts are correct, click on a button according to the type of text you want 
to create as follows:

Object
The Object option creates    the wording from individual cross stitches but maintains the 
connection between them.    This means that you can go back to the original dialogue box at 
any time in the future and change the wording, font and style.    You can also change the 
position in the design, the colour and even the size by using the Object select tool.    The 
dissadvantage is that you cannot edit each stitch on an individual basis.    The program will 
always control the look of the words from the styles you select.

Cross
This option simply creates the text from cross stitches as in previous versions.    This option 
will also use 3/4 stitches to smooth out the edges if the 3/4 stitch option is checked.    The 
stitches produced have no connectivity like the Objects so the wording of the text cannot be 
changed later, except by hand modifications.    The advantage of using this option is that 
minor changes to the stitch layout can be made by hand.    With the Objects, all the stitches 
must remain unchanged.

Back
This option will create text from Backstitches rather than cross stitch.    If used with the 
Diagonal backstitch option, the letters will look smoother.

Cross / Back
This option combines the Cross and Bacckstitch options to give lettering in Cross Stitch with 
outlining in black backstitch.



Deleting Stitches
Stitches may be deleted with the mouse or with the mouse in conjunction with the keyboard.

The procedures are exactly the same as for Adding Stitches but the right hand mouse button
is used.

See Also:
Area Delete
Adding Stitches



Modifying Colour Palette
Up to 220 colours may be used simultaneously with XStitch Pro.    Initially, each colour in the 
palette is set to one of the predefined DMC colours but these may be changed at any time.    

If the current graphics mode does not support the chosen colour then a dithered colour will 
be provided.    

Dithered colours may not give an acceptable display when the size of stitches is small since 
the dithering technique requires a reasonably large area of colour to produce a good effect.

Modification Methods:
Choosing a new DMC colour
Creating a custom colour
Creating a custom colour and choosing the nearest DMC colour



Choosing Colour
With the mouse, simply click the left button with the mouse pointer over the required colour 
from the palette. 

The colour palette can be scrolled to show colours that are off the screen.

Only 220 colours may be used at any time but these may be chosen from the full DMC or 
Anchor ranges or customised.

See Also:
Palette Modify



Exiting
The program is terminated by selecting the Exit command from the File menu.

If the current design has been changed and is not saved then a prompt will be made to allow
the operation to be aborted.

If the warning is ignored then the current design changes will be lost and the program will 
terminate.

See also:
File Save
File Save as
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Bitmap Objects
Block Copy
Block Cut
Block Define
Block Delete
Block Fill
Block Filled Shape
Block Menu
Block mirror
Block Open Shape
Block Paste
Block ReflectX
Block ReflectY
Block Rotate
BMP
Brooktrout
buy
C
CALS
Choosing a new DMC colour
Choosing Colour
CLP
Colour Change
Colour Swap
Colour Symbols
Contents
Creating a custom colour and choosing the nearest DMC colour
Creating a custom colour
Cross Stitch Tool
D
DCX
Deleting a Bitmap Object
Deleting Stitches
Design AH
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Design Crosses
Design Grid Interval
Design Grid
Design Menu
Design Symbols
DIB
E
Edit colour ranges
EPS
Exiting
F
File Autosave
File Exit
File Get Backup
File Import
File Menu
File New
File Open



File Print
File Printer Setup
File Save
File Saveas
File Scan Source
File Scan
Flood Fill Tool
French Knot
G
G3
G4
GIF
Glossary
H
Half Stitch Type A
Half Stitch Type B
Half Stitch Type C
Half Stitch Type D
Half_cross_stitch
HALO Cut
help Custom Size
Help Menus
help Sizes
Help
I
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Index
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J
JPEG
K
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L
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M
MAC Paint
Microsoft Paint MSP
Modify Object
Modifying Colour Palette
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N
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newimports
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O
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P
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Possible Problems
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Q
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T
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U
Undo
W
whatsnew
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X
Xbitmap XBM
XWD
Z
Zoom In
Zoom Menu
Zoom Out
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Possible Problems
This page describes any know problems which have been reported in using the software.    
These are generally problems in other software and hardware packages that affect the 
operation of Cross Stitch Professional for Windows. Where possible, workarounds are given.

Old versions of Monotype Sorts font
A version of the Monotype Sorts font believed to have been included in some Lotus products 
causes text to be displayed as symbols.    If text in the program and on the buttons appears 
as symbols, check for the existance of this font on your system and delete it.    If your text 
appears normal then you either don't have this font or you have a good version of it.

Some Hicolour cards
Some video display cards when running in Hicolour (32K or 64K colours) do not correctly 
display the stitches and fabric backgrounds.    Symptoms are a heavy red or blue colour cast 
or stitches that look almost transparent.    Often reducing to 256 colour mode or increasing 
to truecolour (16M colours) will solve the problem.    Alternatively, switch the program into 
Grid display with colour blocks.

Power MACS / Softwindows
If running under softwindows on a PowerMAC, it may be necessary to set the Windows 
emulation to 16 colour for reliable operation.    This should not affect the programs ability to 
display in truecolour.    Note that PowerMAC information is provided by Cross Stitch 
Professional customers as we do not directly support this platform.    We will however 
attempt to obtain solutions to any problems you may find.



Title



Auto Backstitch
The Auto Backstitch



Backstitch Diagonal Type A

The Diagonal Type A Backstitch tool is used to add backstitches down the top left/bottom 
right diagonal of a stitch.    Any stitch drawn with the tool selected will be a diagonal type A 
stitch.

All backstitches are shown in one colour (black).

Deleting with any backstitch tool selected will delete any type of back stitch but will not 
affect cross stitches or half stitches.



Backstitch Diagonal Type B

The Diagonal Type B Backstitch tool is used to add backstitches down the top right/bottom 
left diagonal of a stitch.    Any stitch drawn with the tool selected will be a diagonal type B 
stitch.

All backstitches are shown in one colour (black).

Deleting with any backstitch tool selected will delete any type of back stitch but will not 
affect cross stitches or half stitches.



Backstitch Horizontal

The Horizontal Backstitch tool is used to add backstitches across the top of a stitch.    Any 
stitch drawn with the tool selected will be a horizontal back stitch.

All backstitches are shown in one colour (black).

If a back stitch is required across the bottom of a stitch, it should be added across the top of 
the stitch underneath. Since adjacent stitches share the same two holes, this is exactly 
equivalent.

Deleting with any backstitch tool selected will delete any type of back stitch but will not 
affect cross stitches or half stitches.



Backstitch Vertical

The Vertical Backstitch tool is used to add backstitches down the left hand side of a stitch.    
Any stitch drawn with the tool selected will be a vertical back stitch.

All backstitches are shown in one colour (black).

If a back stitch is required down the right hand side of a stitch, it should be added down the 
right hand side of the stitch immediately to the right. Since adjacent stitches share the same
two holes, this is exactly equivalent.

Deleting with any backstitch tool selected will delete any type of back stitch but will not 
affect cross stitches or half stitches.



Bead
The bead tool is used to add beads to a design.    A bead can be located in 9 positions on 
each stitch, not just once in each stitch position.

Beads use the same colours as the rest of the design so it is recommended that you choose 
an unused colour and then change the colour description so that it indicates a bead on the 
printed pattern.    You can of course customise the colour of the bead as well.



Cross Stitch Tool

The cross stitch tool may be selected by clicking on the cross stitch button of the toolbar or 
selecting the icon from the Tool Menu.

All stitches drawn with the cross stitch tool selected will be a full cross of the currently 
selected colour from the colour palette.

Placing a cross stitch will erase any stitch previously at the same position with the exception 
of Backstitches which remain unaffected.

Deleting a stitch with the cross stitch tool selected will delete any stitch or half stitch but not
a back stitch.    Back stitches may be erased by selecting one of the back stitch tools and 
then using the right hand mouse button or the delete key in the normal way.



Flood Fill Tool

The flood fill command is used to fill an irregular shape with stitches of the selected colour.

The mouse should be clicked somewhere inside the shape to be filled after selecting the 
tool.

The area to be flooded must be completely enclosed by stitches or the flood will leak out and
fill the whole design.    It is recommended that the design is saved prior to using this 
command in case this happens.    The old design may then be recovered using the file open 
command.

If the flood fill is started at a position occupied by a stitch then only stitches of the same 
colour will be affected.    If the start position is blank then all existing stitches will be 
unaffected.

Note that some video drivers do not support the floodfill function used for this command, in 
particular most Truecolour drivers.    In these cases, the command will not work ( or under 
Windows 3.0 may cause a crash )



French Knot

The french knot stitch differs from the other stitch types in that it is placed on the 
intersection of grid positions rather than inbetween them.

The same process applies to adding and deleting stitches as with Cross Stitches.

French Knots may be placed in any colour but a colour printer will be needed to distinguish 
between them on the printed pattern.



Half Stitch Type A

The Half Stitch Type A tool is one of four different orientations of half stitch.

Any stitch drawn with a half stitch tool selected will be drawn as one half of a complete cross
stitch.

A half stitch will erase another half stitch of the same orientation at the same location.    It 
will also erase a half stitch if it shares any part with the existing stitch.

If the existing stitch is a half stitch of opposite type they will be joined to form a either a 
whole stitch if the colour is identical, or a double coloured stitch if the colours are different.

Erasing with a half stitch tool selected will erase whole stitches or half stitches but not back 
stitches.
 
Erasing a back stitch is done by selecting a back stitch tool and using the right hand mouse 
button or the delete key in the normal way.



Half Stitch Type B

The Half Stitch Type B tool is one of four different orientations of half stitch.

Any stitch drawn with a half stitch tool selected will be drawn as one half of a complete cross
stitch.

A half stitch will erase another half stitch of the same orientation at the same location.    It 
will also erase a half stitch if it shares any part with the existing stitch.

If the existing stitch is a half stitch of opposite type they will be joined to form a either a 
whole stitch if the colour is identical, or a double coloured stitch if the colours are different.

Erasing with a half stitch tool selected will erase whole stitches or half stitches but not back 
stitches.    

Erasing a back stitch is done by selecting a back stitch tool and using the right hand mouse 
button or the delete key in the normal way.



Half Stitch Type C

The Half Stitch Type C tool is one of four different orientations of half stitch.

Any stitch drawn with a half stitch tool selected will be drawn as one half of a complete cross
stitch.

A half stitch will erase another half stitch of the same orientation at the same location.    It 
will also erase a half stitch if it shares any part with the existing stitch.

If the existing stitch is a half stitch of opposite type they will be joined to form a either a 
whole stitch if the colour is identical, or a double coloured stitch if the colours are different.

Erasing with a half stitch tool selected will erase whole stitches or half stitches but not back 
stitches.    

Erasing a back stitch is done by selecting a back stitch tool and using the right hand mouse 
button or the delete key in the normal way.



Half Stitch Type D

The Half Stitch Type D tool is one of four different orientations of half stitch.

Any stitch drawn with a half stitch tool selected will be drawn as one half of a complete cross
stitch.

A half stitch will erase another half stitch of the same orientation at the same location.    It 
will also erase a half stitch if it shares any part with the existing stitch.

If the existing stitch is a half stitch of opposite type they will be joined to form a either a 
whole stitch if the colour is identical, or a double coloured stitch if the colours are different.

Erasing with a half stitch tool selected will erase whole stitches or half stitches but not back 
stitches.    

Erasing a back stitch is done by selecting a back stitch tool and using the right hand mouse 
button or the delete key in the normal way.



Half_cross_stitch
The half cross stitch is a single diagonal stitch which is stitched over one stitch position.    
There are two tools available, one for each direction of the diagonal line.

On a symbol chart, this stitch is represented by two identical smaller symbols at opposite 
corners.



Help
The Help tool simply displays this help file.



Line of Stitches
The Line of Stitches tool is a conveniant way to draw a line in cross stitches.    The line can 
be to and from any stitch position regardless of angle.

Click and hold down the left mouse button at the start of the line.    Move the mouse to the 
ned of the line and release the button.    While the mouse is moving, a line will be drawn 
representing the path the line will take.    When the button is released, this will be replaced 
with a line of cross stitches in the currently selected colour.

For a way to smooth out the jagged edges of line, see the Smoothing Tool



Modify Object
The Modify Object tool is used to alter an existing Bitmap or Text Object.

Text Objects
Clicking on the Modify Object tool with a text object selected will cause the original dialogue 
to be displayed.    This will allow you to change the wording and font of the text object or 
even to convert it to Stitches or Backstitches.

Bitmap Objects
Clicking on the Modify Object tool with a Bitmap Object selected will allow the object to be 
converted to stitches.    Since any stitches beneath it will be erased, a prompt is issued prior 
to carrying out this operation.



What's new - Exports
When the Print command is used, the option now exists to create a graphics file instead of a 
printout.    This is used to export the output of the program so that it can be used for 
publishing or importing into other programs.

Please note that a large amount of memory will be required to use this option as a graphics 
file is created at the full resolution of the selected printer.    This will be especially large if a 
colour printer is selected.    In addition to a large amount of RAM, a large virtual swap file is 
recommended.

Return to What's new V4



What's New - Hints
Whenever the mouse pointer is left stationary over a tool or other active area of the screen 
for a few seconds, a yellow popup hint will appear to identify the purpose of the tool.    This 
feature can be dissabled from the Help menu when the user has learned all the commands.

In addition, there is a hint bar at the bottom of the screen.    This displays what action you 
can carrry out with the currently selected tool given the current position of the mouse.    
During lengthy operations, it changes to a progress bar to inform the user that the program 
is busy and the likely time that will be taken.

Return to What's new V4



Whats new - Imports
The program continues to support graphics imports in over 30 formats and to match them 
accurately to the threads in the current range.

The important change is the use of a multi-pass colour reduction algorithm which will 
continue to change the imported image until the best results are obtained.    You simply have
to specify the number of colours you want in your design and then let the program do all the
work.    A halt button is provided which will terminate the search for perfection and give you 
the best so far.

Note that the use of GIF and TIFF-LZW formats in programs require the programmer to be 
licensed.    The author of Cross Stitch Professional for Windows is a holder of such a license 
and an appropriate fee is paid to the patent holders for each copy sold.    The user of the 
program does not therefore require a license to import these files.

Supported File Formats
Return to What's new V4



Other Colour Ranges
Adding extra colour ranges to the standard DMC, Anchor and Paternayan Persion wool can 
be done in two ways.    Firstly, it can be added by using the colour range editor built into the 
program.    Secondly, a colour chart can be sent to the program author.

Return to What's new





Pen Width
Most programs add a single stitch as the mouse enters a new stitch position however Cross 
Stitch Professional for Windows allows a faster method of covering larger areas.

The width of the "Pen" used to draw stitches can be increased thus drawing more stitches for
each click or movement of the mouse.

The current pen width is indicated buy a small number on the Pen Width tool.

To change the pen width, select the pen width tool which will cause it to display all the 
available widths.    Simply select the appropriate pen width from those displayed and the tool
will be changed to indicate the new width.

The pen width will also affect the width of the Lines of Crosses and open shape tools.



Quarter_Stitch
There is a seperate quarter stitch tool for each of the possible 4 positions within a full cross 
stitch.

By selecting a colour and the correct 1/4 stitch tool, it is possible to place 4 different colours 
of stitch at the same grid position.

On a symbol pattern, these stitches are represented by a smaller symbol placed at the 
appropriate corner of the grid position.



Redo
Pressing the Redo button on the toolbar will reverse the effect of the Undo tool (that is the 
last command will be replayed).    This button is only enabled when there has been an undo 
operation that can be restored.



Redraw
The redraw tool is used to refresh the screen and to update the position of centre marks and 
width/height displays (when turned on).

Since these indicators require scanning each stitch in the design, the speed of the program 
would be dramatically reduced if this was done after every addition or deletion.

The other time when screen redrawing may become necessary is when deleting stitches 
where backstitches exist.    Again this is to ensure that the screen drawing is as fast as 
possible.



Stitch Info

The Stitch Info tool is used to read back the colour of a stitch which is already on the design. 
When the tool is selected, the colour name of the stitch below the mouse pointer will be 
displayed underneath the X,Y readout display.

To select the colour of a stitch on the design in order to continue stitching with it, simply 
click the left mouse button over the stitch.    This will not only select the colour of the stitch 
but will also automatically select the Cross Stitch tool.



Symbol Assignment
Assigning symbols is as easy as picking up the required symbol and dropping it onto the 
required colour.

The symbol assignment dialog is reached by double clicking on the display of the symbol for 
the current colour (just below the colour sample).

At the top of the dialog, is a list of the colours in the current palette.    At the bottom is the 
symbol set contained in the current font.

To change the symbol for a given colour, pick up a symbol with the mouse, drag it onto the 
colour and release it.

To change fonts, click on the font button and select from the list of all installed fonts.



Toolbar
The toolabr contains buttons to select the type of stitch to be used.    It also contains buttons
to zoom in and zoom out, undo an operation and to enter stitch info mode.

For more information, select a Tool below:

 Cross Stitch
 Half Stitch Type A
 Half Stitch Type B
 Half Stitch Type C
 Half Stitch Type D
 Back Stitch Horizontal
 Back Stitch Vertical
 Back Stitch Diagonal Type A
 Back Stitch Diagonal Type B
 Backstitch Line
 French Knot

 Block Define
 Flood Fill
 Text Object
 Bitmap Object
 Object Select
 Stitch Info
 Zoom in
 Zoom out



Zoom In

The Zoom in tool enlarges the pattern display by one level.    If the tool is greyed out then no
further enlargement is possible.

See Also:
Zoom Out



Zoom Out

The Zoom out tool is used to reduce the size of the pattern display by one level.    If the tool 
is greyed out, no further reduction is available.

See Also:
Zoom In



Truetype Symbols
Previous versions of the program used bitmap symbols that were built into the program.    
This version uses any truetype font to provide graphics symbols for each stitch colour.    The 
advantage of Truetype fonts is that the user can select a different set of symbols just by 
swapping to a different font.    There is also a great improvement in printer speed.

Symbols can now be assigned to colours by the use of Drag and Drop.

See Also:
Symbol Assignment
Return to What's new V4



Undo
Clicking on the Undo tool on the toolbar will reverse the effect of the last command.    This 
tool is only enabled when there is a command stored that can be undone.

The effect of the Undo tool can be reversed by using the Redo tool.

Only one level of Undo is supported so it is not possible to undo more than the last 
command.    You should save on a regular basis to different filenames in order to preserve 
previous versions.



Autosave
<File Autosave>



Back Stitch
A Back Stitch is a stitch forming a line which is usually used to outline part of the design.    
The program allows single unit length stitches in one colour (black on screen) and any length
stitches in any colour at any angle (called backstitch lines).



Block Define
<Block Define>



Block Filled Shape
<Block Filled Shape>



Block Open Shape
<Block Open Shape>



Colour Editor
<Edit colour ranges>



Cross Stitch tool



Cross stitch
<(None)>



Dithering
Dithering is a process which enables colours which cannot be directly drawn by the graphics 
card to be simulated.    This is done by drawing patterns of dots in different colours so that 
the affect when viewed at a distance is similar to the required colour.



French knot tool
<French Knot>



French knots
<(None)>



GIF
<GIF>



Half Stitch
The term half stitch is used in this program to mean a stitch which takes up less than the full
cross.    Strictly speaking this is a 3/4 or 1/4 stitch since when two half stitches are used 
together, the dividing diagonal must be chosen to be just one of the colours.    In the 
program, the diagonal is shown in both colours and it is up to the stitcher to choose which is 
the 1/4 and which is the 3/4.



match colours
<Palette Match Colours>



Mirror
<Block mirror>



non-palette displays
A display which supports palettes can have one colour substituted for another without 
redrawing the screen.    This allows very fast colour substitutions but such displays are 
normaly restricted to 256 colour modes.    A display which operates in a non-palette mode 
requires a redraw if a colour is changed.



Object Select
<Object Select Tool>



old method
The old method of scaling used a percentage Design Scale.    A value of 100% always printed
a single page.    200% would print at twice this size, 300% at 3 times etc.    The problem with 
this method was that the actual symbol size varied according to the pattern size.    If stitches
per inch is set to zero, this Design Size method may still be used.    The value is set on the 
Scales tab of the print dialog.



older method
The old method of scaling used a percentage Design Scale.    A value of 100% always printed
a single page.    200% would print at twice this size, 300% at 3 times etc.    The problem with 
this method was that the actual symbol size varied according to the pattern size.    If stitches
per inch is set to zero, this Design Size method may still be used.    The value is set on the 
Scales tab of the print dialog.



Palette
A Colour Palette is a collection of colours which can be selected for drawing in the same way 
that an artist selects colours from a palette containing paints.    A Tool Palette is simply a 
collection of tools which can be selected for use.



PNG
<png>



range
A colour range is one particular manufacturers set of thread colours.    The program comes 
with the entire set of DMC and Anchor ranges but others can be created with the colour 
range editor.    The range being used may be changed from the Palette menu.



Scan Source
<File Scan Source>



Scan
<File Scan>



SHOW_WH
<Show WH>



Smoothing Tool
<newsmooth>



Stitch Info
<Stitch Info>



symbol mode
<Design Symbols>



TIFF-LZW
<TIFF>



TWAIN
TWAIN is an industry standard for scanner interfaces.    Any scanner that is supplied with a 
TWAIN compliant driver can be used with Cross Stitch Professional for Windows.    For other 
scanners, it will be necessary to use the program supplied with the scanner to create a 
graphics file.    This file can then be converted to a pattern with the File Import command.



Zoom in
<Zoom In>



Zoom out
<Zoom Out>






